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REELtime
Digital Video Processing Software

REELtime is a tool for creating video clips that can be used in multi-
media presentations, or edited in programs such as Animator Pro and
PhotoStyler. You can capture live video sequences and store them on
your computer’s hard disk in digital format.

Grabbing single frames and converting them to the correct file format
used to take hours. With REELtime this task can now be accom-
plished in a matter of seconds. Using a presentation package like Ima-
geQ from ImageNorth, you can add audio to the clip during your pre-
sentation.

REELtime operates under the Windows 3.1 software environment in
combination with Cardinal Technologies’ SNAPplus board.

The input video signals can be Composite, S—Video or RGB at NTSC
or PAL frequencies. These signals are input to the SNAPplus board,
saved to hard disk in FLC or TGA format and incorporated into a
variety of multimedia applications.

REELtime User’'s Manual 3



Introduction

Manual Organization

This manual is divided into five parts.

PartI Getting Started .............. page: 5
Part I Capabilities . ................ page: 9
Part III Step-by-Step Instructions . ... page: 29
Part IV A Video Tutorial ............. page: 49
Part V. Applications ................ page: 59

InPartIyou will find hardware requirements, how to install REEL time on your sys-
tem and how to get started.

In Part IT we describe the capabilities of REELtime. We explain the functions of the

commands in the menu bar and show you how to use them.
In Part Il we presenta step—by—step instruction guide on how to execute the various
functions of REELtime.

In Part IV we discuss commonly used terms and we explain their meaning.

In Part V we show you some examples on how to get the most out of REELtime. #

Throughout this text we will use terminology pertaining to the MS-DOS and Win-
dows environment; we therefore assume that you possess a working knowledge of

MS-DOS and Windows. G e tti n g S ta rte d

4 REELtime User’s Manual REELtime User’s Manual
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Hardware Requirements

The minimum system requirements for REELtime are:

CPU: 80386DX/33Mhz
80486SX/25Mhz

RAM: 8Mb; 16Mb recommended

Fixed Drive: 4Mb of free space

Diskette Drive: 3.5”1.44Mb
SNAPplus Board: one

10.

11.

12.

Loading REELtime

Make certain that you have Windows 3.1 installed. If this has not been done —do
it now.

Create a directory on your hard drive and call it REEL time.

Example: C:> md REELtime —

. Copy all files on the REELtime diskette to the REEL time directory; the assump-

tion is to use drive A.

Example: C:> copy a:*.* c:\REELtime —
Go into Windows; double—click on the Program Manager icon.
Click on NEW to create a new program group.

In the Description field type:
REELtime. You can leave the Group File field blank.

Click on OK to create a new Windows folder called REELtime.

With the REELtime folder open, click on NEW in the program manager win-
dow to create a new program item.

In the Description field type:
REELtime.

In the Command Line field type:
c¢:\REELtime\REELtime.exe

Click on OK to create a new program item.

The REELtime icon should now appear in the work group.

REELtime User’s Manual 7



Part I — Getting Started

Quick Start

You start REELtime from the Windows environment; proceed as follows:

Change to the directory where you installed Windows, i.e.

CD:\WINDOWS

WIN/S (We recommend starting Windows in the standard mode to
avoid severe breaks in the video clips.)

Make certain you have loaded REELtime properly pm REELGimc
and you have established a new work group. Your
Program Manager window should display the RE-
ELtime icon, which we are showing here.

Connecta video source, such as a VCR, to the video input connector of the SNAP-
plus board — supply video and connect a monitor to the VGA output.

Double click on and the

REELtime picture will be displayed.

VGA Output

Videa Input

FEENms.
Evr_Capione " Hew

Figure 1 — Component Hook—up

You can wait for the REELtime picture to
disappear or you can click on it, using the
left mouse button. You will be left with a
blank REELtime screen — you are now
ready to use the Digital Video Processing Software.

8 REELtime User’s Manual
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o

Capabilities

In Part IT of the User’s Manual we explain the pull-down
menus, what their functions are, how to access them and
what they are used for.

Contents
Chapter 1 The File Menu .......... 11
Chapter 2 The Capture Menu ....... 19
Chapter 3 The Options Menu ....... 25

REELtime User’s Manual
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The File Menu

Step-by-step instructions start on page: 31

With the commands in the File menu you can:

[& Open afile

& Set up the video parameters
using Preferences

[7F Exit the program
[Z3 Find the version number (About REELtlme)

Before you perform any operation in REELtime you have to adjust the video param-
eters using the Preferences dialog box. Unless you set all levels properly images
that you will save on disk may not be to your liking; i.e. you may see distortions on
either side, or the picture quality is not good, etc. You should pay special attention
to the Acquisition Window adjustments; see Section 1.1.4 on page 14.

E  Dreferences... CirisP

q Exit ctri+Q
i|_avout REELtime...

1.1 Preferences
See also page: 33

In the Preference dialog box you can adjust image or picture quality, determine the
video source, the video rate, and you can eliminate or reduce distortions on the in-
coming video.

1.1.1 Scroll Bars

See also page: 34
The mouse is used to [ S T Preferences . 1
drag the scroll bars. Video Source Name: [setup1 l
With the scroll bars rPicture Ad;ust [Color Adjust — ] [TAcquisition Window

. Left: 134
video parameters for

optimum picture

quality and range. Right 777

¥ B8 SRR
N RS FB LR R A

you can adjust the

ﬁ

Bri Con Sat Hue Red Green Blue

Top: 19
R

AALEEE000 BRI ¥ Y

R

Bottom: 259

3>

The default settings

are: 57 67 63 55 || 75 75 75

Picture Adjust: 50

Color Adjust: 75 [Video Input Video Rate

Video Input: Com- @® Composite O RGB Separate Sync || ©NTSC!

posite O'sviden O RGB SyncOn Green || O PAL

Video Rate: NTSC

Video Source Name:

Default

REELtime User’s Manual 13
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1.1.2 Picture Adjust
See also page: 34

1.1.3 Color Adjust
See also page: 34

The four vertical scroll barsare usedto ~ The three vertical scroll bars are used to
fine-adjust Brightness, Contrast, Sat-  fine-adjust the Red, Green and Blue
uration (color) and Hue (tint.) More  color levels of your incoming video.
details will be available in the Video = More details will be available in the
Tutorial, starting on page 53. Video Tutorial, starting on page 53.

Picture Adjust — Caolor Adjust

S

Bn Cun Sal Hue Red Green Blue
57 67 B3 5% 7% 75 75

1.1.4 Acquisition Window
See also page: 35

The proper adjustment of the Acquisition
Window is a pre-requisite for obtaining a dis-
tortion free input video picture. It should be | Left: 134
the first adjustment you make before you cap-
ture images. Top: 13

[ Acquisition Window

In the acquisition window you can adjust the | Right: 777
raw video as it comes in from a video source,
suchasa VCR. As youexamine this videoyou | Bottom: 259
may notice distortions on either side and on
the top and bottom of the video window.
These distortions are inherent to video
sources and the amount and intensity may vary from device to device. Moving the
horizontal scroll bars in this dialog box will allow you to cut off these distortions
on all sides of the window.

14 REELtime User’s Manual
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1.1.5 Video Input
See also page: 35

Video input coming from a source can be:

Composite low video quality, single cable terminating in an RCA plug%

S-Video good video quality, two conductor cable plus ground with a four pin
mini-DIN connector. (&3
RGB highest video quahty, four conductors plus ground, terminating in a

BNC connector; § one for each conductor.

More details will be avaﬂable in the Video Tutorial, starting on page
53.

1.1.6 Video Rate
See also page: 36

Videorate refers to the type of video rate your device can supply. NTSC is common-
ly used in the USA and Japan and PAL is used in Europe; see the Video Tutorial,
starting on page 53.

1.1.7 Video Source Name
See also page: 36

The intensities and strengths of video signals, generated by different sources, can
Vary a greatdeal. Itis therefore imperative that the appropriate adjustments be made
for each video source with which you intend to work. For example, you may employ
several VCRs, Video Discs or Video Cameras as input devices. For each of these
devices the video
parameters will have to be
adjusted using the
Preferences dialog box.
After you have completed
these adjustments you can
enter a unique name in the ' K OE & g FvT -
Video Source Name box to identify the video source. Instead of having to make
the adjustments again for the same video source you can simply recall these settings
by the name you had previously assigned to that particular video source.

Preferences

REELtime User’s Manual 15
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1.2 Open

See also page: 39

Openisusedtodisplay pre-
viously saved (on hard
disk) video files. A list of
input file types is available
in the List Files of Type
box.

1.2.1 List Files of Type
See also page: 39 — Step 2

The List Files of Type dialog box lists all cur-
rently available input file types.

1.2.2 Play Control Dialog Box
See also page: 40

After you have opened a file the Play
Control Dialog Box will pop up. The yel-
low buttons control the movement of your
recorded video, much the same way you
control a VCR.

The obvious functions are identi-
e\,e‘e’e fied in the picture. File info and
[ go® Speed control will be explained
“o@d 8 in the next Sections.

@l

: ?:\)%0
O &
€\\0\‘\& 00(\'6
= gqeed
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1.2.3 The Info Dialog Box

The Info Dialog Box displays the parameters
associated with the file you are viewing.

H Filename JTRC
Fll-ename ) Path : cAwindowslsystem
This entry refers to the name of the file you are Numberof Frames :15

. . Flle Skze 1296736 bytes
viewing. Average Frame Size : 19786 bytes
Path Resolution :158x116

This entry shows the file path.

Number of Frames

This entry shows how many frames you had cap-
tured.

File Size

This entry shows the size of the file in bytes.

Average Frame Size

This entry shows the average frame size — file size/number of frames=average
frame size.

Resolution

This entry refers to the resolution of your captured video. A Small Frame will result
in poorer resolution and a Large Frame will result in better resolution; (see page
21.)

1.2.4 Speed Control

Speed The speed bar adjusts the playback speed of the current

ET file. The number to the left represents the delay time be-
tween each frame; the higher the number, the slower the playback speed — the lower
the number the faster the playback speed.

The actual speed of playback varies depending on how much graphic information
is displayed in each frame and how much graphic information is changing between
frames. Playback speed also depends on the speed of your computer and video card.

1.3 Exit
Exit will leave the REELtime program.

| 1.4 About REELtime |

Clicking on this entry will display the version of the REELtime Digital Video Pro-
cessing Software you are working with.

REELtime User’s Manual | iz
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The Capture Menu
21 SmallFrame ..........cccovviinnnnnn... 21
2.2  Large Frame .. ...:.uisississssssionisssss 21
23  The Capture DialogBox ................ 22
2:3:10 File TYPeS . iis ciecte - so v e s oraiaralsioin o e s ol 22
232 FileName ..........oovviiiiininnannn. 22
233 FrameRate ..........ccooiiiiiiiiiaann 22
234 StartingFrameNo. ..................... 23
235 NumberofFrames ..................... 23
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The Capture Menu
Step-by-step instructions start on page: 45

The commands in the Cap- N S —_——
ture menu are used to capture { File BeiHEE Options Help

¥ z Small Frame {160x120}... Ctri+S
and sa.ve live video on Your Large Frame (320x240)... Ctrl+L
hard disk.

You can:

[& Capture video in a small
frame.

[=F" Capture video in a large
frame.

| 2.1 Small Frame |

The size of the small frame is approximately 160x120 pixels. A small frame occu-
pies about 18 Kb of disk space. The resolution of a small frame is not as good as that
of a large frame. If you want to store video frames with better resolution you should
use the Large Frame command; see the next Section.

Advantage: uses less disk space; higher frame rate (more frames/second)
faster playback speed.
Disadvantage:  lower resolution.

| 2.2 Large Frame

The size of the large frame is approximately 320x240 pixels. A large frame occupies
about 75 Kb of disk space. The resolution of a large frame is better than that of a
small frame. If you want to store video frames with lower resolution you should use
the Small Frame command; see the previous Section.

Advantage: higher resolution.
Disadvantage:  uses more disk space; lower frame rate (less frames/second)
slower playback speed.

REELtime User’s Manual 21
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2.3 The Capture Dialog Box
See also page: 46

The options in the Capture dialog F3 R
box are the same whether you se- . mene: TR
lectasmall frame or a large frame / e

e ]
alone.fic
in which to capture live video. P [
Din  cireeitime

=) £
B reeitime I
£

2.3.1 File Types

You can specify the file type, FLC

or TGA, to be stored to disk. FLLC _|
files are stored in compressed for-
mat, they therefore use less disk
space than TGA files. TGA files
are stored as is, they use up disk space but are easier to edit and the color resolution
is much better than FLC files. Of course if you intend to export these files to other
programs, such as Photostyler or Animator Pro, you have to make certain that you
use the correct format. Photostyler can process TGA files, while Animator Pro can
process FLC files.

FLC file names can be 8 characters long and TGA file names can be 4 characters
long.

2.3.2 File Name

Fie Type: [Flcwe ]
You can assign a unique ﬁ_le name to each video se- | name:
quence that you are recording; later on you can open ——— =

one.fic 1

the file by that name. foxflc o

2.3.3 Frame Rate

The frame playback rate on a VCR is 30 fps (frames
per second.) This means thatin one second 30 individ-
ual frames are shown on your monitor. The pauses be-
tween frames (at that rate) can not be discerned by the
human eye; the motion appears very smooth.

The frame rate of capture in REELtime can vary from
15 fps down to .1 fps.

At 15fps we can capture every 2°d frame;  30/15 = 2; playback is smooth.
At 5fps we can capture every 6 frame;  30/5=6

At 1fps we can capture every 30t frame; 30/1 =30

At .1fps we can capture every 300t frame; 30/.1 = 300; playback is jerky.

22 REELtime User’s Manual
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As we can see a video, captured at 15fps, will play back much smoother than one
captured at .1fps.

So why do we want to capture video at .1fps?

At .1fps we can capture more video (a longer sequence of the tape) than we can at
15fps. However, at .1fps we skip more frames than we would at 15fps and therefore
the playback looks jerky when captured at . 1fps.

2.3.4 Starting Frame No.

This function is active only when you record a TGA file. You can assign starting
numbers to the frames of your sequence.

2.3.5 Number of Frames

You can specify how many frames you want to capture;
the default is 30. The maximum number of frames you
can capture, using the small frame window, is 457; us-
ing the large frame window you can capture a maxi-
mum of 104 frames — the minimum is one frame.

Frame Rate: |15 fps 2

B710 be able to capture the maximum number of frames you need 16Mb of RAM4
®If not enough disk space is available, nothing will be savedq

2.3.6 Set

When all the settings in the Capture Dialog Box are to your satisfaction click on

{ and they will become current.

2.3.7 Start

Clickon

capture sequence gets placed into RAM (Random Access Memory) and from there
it gets written to disk. When you capture video at .1 fps you will notice that the mes-
sage below the video window Grabbing frames to RAM stays up for some time be-
fore it informs you that it is saving to file — Frame 0.

to start the capture process. As soonas you initiate Start the entire

2.3.8 Cancel

Click on |Tantel] to cancel the entire operation and you will return to the main
REELtime window.

REELtime User’s Manual 23
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The Options Menu
3.1 GrayscalePalette ...................... 27
3.2  Color Optimized Palette ................ 27
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The Options Menu
See also Step 2 - page: 45

The commands in the Op-

A REELtime
tions Menu are used to se- lle Capture eSOt
: s v GrayScale Palette Ctri+G
lect the v1deo_capture pa} e
ettes. The Options Menu is
effective on FLC files only.
You can:

= Capture video in Grayscale.
=" Capture video in Color.

3.1 Grayscale Palette

Grayscale is the Default setting. Once you invoke Grayscale Palette the video will
be captured in grayscale. This mode has to be set before you do any capture.

When saving to TGA files, the grayscale palette is simulated by removing the satu-
ration from the incoming video. This will work for composite video and s—video,
but will not work for RGB video. REELtime cannot save RGB video as grayscale
for TGA files.

3.2 Color Optimized Palette

26

Once you invoke Color Optimized Palette the video will be captured in color. This
mode has to be set before you do any capture.

When saving to an FLC file, REELtime will convert the digitized video from
16-bits (65,536 colors) down to 8-bits (256 colors). REELtime has been designed
for optimum efficiency; it looks at the colors used in the entire clip, and selects 256
colors to represent all of these colors. If a grayscale palette is selected, these 256
colors will be converted to 256 shades of gray.
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Part 111

A Step—j?y—Step
Instruction Guide

Part ITI of the User’s Manual is a step—by—step instruction
guide to show you how you can display captured video
files, set the video parameters to obtain good video
frames, and how to capture video sequences on your hard
disk.

The steps you must follow have been clearly called out.

Contents
Chapter 4 Setting—up Preferences .......... 31
Chapter 5 How to Open a Video File ....... 37
Chapter 6 How to Capture Video .......... 43
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Setting—up Preferences

For a general discussion see page: 13

Before you attempt to capture video you should make the various adjustments to get
a good picture, using the Preferences dialog box.

Step 1

Connecta video source to the input of your SNAPplus board, connect a monitor and
supply a video signal; see page 8.

Step 2
Start Windows in standard mode, i.e. WIN/s.

!

Step

Open REELtime, i.e. double click on

Step 4
In the Menu Bar click on: =
File Gapture  Qptions

You will get the File pull-down menu, | Preferences..  Ctri+p
pictured to the right. Exit cri+Q
About REELtime...

From the File pull-down menu se-
lect:
Preferences

J{:W Capture Options
Qpen... Ctri+0 |
g Preferences... Ctri+P
Exit Ctrl+@
i About REELtime...
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S Xl Adjust the Video Scroll Bar
See also Section 1.1.1 - page: 13

With the mouse you
can drag the scroll bar
or you canclick on the
arrows to move the
scroll bar one step ata
time. Place the cursor
over the arrow and
hold the left mouse
key for continuous
travel. When the scroll
bar is in the center
position its level is at
50, or mid point;
please observe the
changing numbers be-

Video Source Name:

[Picture Adjust — ]

B OB E B
Bri Con Sat Hue

57 67 63 55

[setup1 ]
["Color Adjust — ] [TAcquisition Window
3
§ Left 134 EEETTETH
- Top: 18
g Right 777
M K B Bottom: 259 [BREEEEEH
Red Green Blue
% 75 75

Video Input

@ Composite O RGB Sep Sync

O svidea

O RGB Sync On Green

rVYideo Rate
@INTSC!

QO PAL

low as the scroll bar moves.

Adjust the Picture Quality

Move the Bri (Brightness) scroll bar up for a brighter picture.
Move the Con (Contrast) scroll bar up or down to obtain the
contrast you prefer. Move the Sat (Saturation) scroll bar
down for a less colorful picture (color adjust) and move the
Hue (Hue or Tint) scroll bar up or down for the tint you pre-

fer.

When an RGB signal is input to the SNAPplus card Satura-

tion and Hue can not be adjusted.

Adjust all levels to your preference.

Si¢]oXsls] Adjust the Colors

The three vertical scroll bars adjust the Red, Green and Blue
color levels of your incoming video. Moving the scroll bars

up will increase the respective color levels.

Adjust all colors to your preference.

Bri Con Sat Hue
57 67 63 55

[Color Adjust — |

Red Green Blue
7% 75 75
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SIS WAl Adjust the Acquisition Window
See also Section 1.1.4 — page: 14

Distortions on either side of the video window
can be reduced or eliminated by moving the re-
spective scroll bar.

For example: take a look at the top of the video
scene coming from a VCR. You can observe
distinct distortions in this area. Using the Top
scroll bar move it or click on one of the arrows
to move it a step at a time, you will observe that
the picture moves in the vertical direction, elim-
inating these distortions. You can do the same
for any distortions you may have on any side of
the video window by moving the appropriate
scroll bar.

[ Acquisition Window

Left: 134
Top: 19
Right: 777

Please keep in mind that you may have to balance the left and the right, the top and
the bottom to achieve the desired results. It may take a little practice to get a final,
good picture. If these distortions have not been completely eliminated or reduced
to your satisfaction when you open a video window, go back to the Preference dia-

log box and adjust them again.

Click on Reset if you want to go back to the settings you started out with.

Select Video Input
See also Section 1.1.5 — page: 15

Place your mouse cursor over the ra-
dio button and click on the type of
video input you are providing.

Please check in the instruction
manual of the video equipment you

Video Input
® Composite O RGB Separate Sync

O s-¥ideo

O RGB Sync On Green

are using for the type of video out-
put signal it provides.

4 Most consumer VCRs supply composite video.
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IRl Select the Video Rate

See also Section 1.1.6 — page: 15 Video Rate

Place your mouse cursor over the radio button and click on the
type of video rate your device can supply.

SIGCRI Enter a Video Source Name
See also Section 1.1.7 — page: 15
After you have made all the adjustments you can enter a unique name in the Video
Source Name box.

1. Click on this arrow to display a list of existing file names.
\

2. Click on the name you [&
want to use and it will be
inserted as the video
source name. In this ex-
ample we have Default,
NEC PC-VCR and
test.

3. If you want to create a
new name bring the cursor over the Video Source Name box and enter the new
name.

4 Please observe the changing setting of the scroll bars as you recall various

Video Source Names — to match the settings of the video source that is being
recalled.

Video Source Name:

SRkl Ending the Preferences Session

Click on and the Preferences you have set will be saved under the
name you had assigned in the Video Source Name.

If you plan to use other Preferences set—ups you can then easily recall each of them
by that name.

Click on [ and you erase the highlighted Video Source Name from
the list.
Clickon 4 to cancel the Preferences set-up session—no changes will

have been made.

Clickon if you want to make temporary changes without saving the
adjustments.
36 REELtime User’s Manual
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How to Open a Video File

51 IHyoucan'tfindthefiles................. 40
5.2  Operating the Play Dialog Box ........... 40
53 AboutREEItime ...................... 41
54 EXit...ooiiiiiiiiiiiiiiiiiie i 41
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How to Open a Video File

For a general discussion see Section 1.2 page: 16
You must have a video file stored on your hard disk before you can

open it.

Tn the Menu Bar click-6r: s~ s

File. Options Help
Ctrl+0

You will get the File pull-down menu Preferences... Cul+P

pictured to the right. Exit Ctl+Q

Step 2
From the File pull-

down menu select:
Open.

You will get the
Open File dialog
box, shown to the
right.

/

Click on this arrow to get a list of available input file formats; at this time only FLC
files can be opened.

Click on a file name, in our example: alone.fl¢ — this

File Name:
name will be placed in the File Name box. Fod
Click on OK and the image file willbe displayed (see | [ioxtie x
picture on page 40)
You may also double click on a file name and the
image file will be displayed at once. &

If the files appear in the File Name box, then choose one and:

[ Step 4 |

otherwise continue with Step 3a.
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5.1 If you can't find the files.

File Name:

If you are pointing to a directory which does not con- €5
tain the files you want to display, or if the File Name
box is empty (see picture to the right), make sure that
you are pointing to the correct disk drive and the cor-
rect directory.

To get there:

Directories:
1. Double click on the disk drive (in our example: do

drive C) containing the directory (in our example:
REELtime) under which you had captured the file
you want to play.

2 pstyler
3 pz

p
W revitime

2. Doubleclick on the directory namei.e. REELtime. File Name:
The file names will now be displayed under the Ed
File Name box. alone fic B

foxflc

5.2 Operating the Play Dialog Box.
SIGCI KR See also Section 1.2.2 - page: 16 7

" ALONEFLC

Click on [E¥H to reverse the direction of the
video by one frame at a time.
Clickon ] tostop the play; click on play and

the video will start from the beginning of the se-
quence.

Click on
sume the sequence.
Click on [Eg to start play.

to pause; click on play will re-

Click on [[=q to forward the direction of the
video by one frame at a time.

Click on

to get information about the frame.
Click on i:[:“j’ to vary the play back speed.
Click on

to close the play dialog box.
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5.3 About REELtime

Click on About REELtime and the
version number of the software will be

displayed, see below. RoLR Copture Options
Open... Ctri+0
Preferences... Ctrl+P
Exit Ctri+@

5.4 Exit

Click on Exit to end the REELtime session.

About REELtime...
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How to Capture Video
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How to Capture Video

For a general discussion see page: 21

Make sure you have a video source hooked up to the SNAPplus board (see page 8.)

Decide whether you want to capture the video in Grayscale or Color.

Click on the Options
Menu.

Grayscale

Click on Grayscale Pal-
ette.
The system is now set to capture video in grayscale.

Step 4
SiClekld Color

After you have chosen Options click on Color Optimized Palette.
The system is now set to capture video in color.

In the Menu Bar click on :
Capture

REELtime

File Capture SWNIGHE

v GrayScale Palette
Color Optimized Palette Ctri+C

=
i File JoctITIN Options Help

Small Frame (160x120)... Ctrl+S
Large Frame (320x240)... Ctrl+L

REELtime

You will get the Capture pull-
down menu pictured to the
right.

Chooseeither a Small Frame or a Large Frame. The resulting Capture Dialog Box
will be the same for either frame, except that the video window size will be different.
Since the steps are the same we will discuss the procedure for a Small Frame only.
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Click on Small Frame and you s ma—
will get the Capture Dialog Box, FreType:

Chpture

pictured to the right. mum@

See also Section 2.3 — page: 22

C'liCk ON | Fiie Type: [TGAfiles

File Type FLCTile

to get a :
listing of file types and make your

choice; see page 22 for details.

|
Bring the mouse cursor into this box and type a unique
name to identify the video sequence you are about to cap- Feane: [utc ]

ture.
J

Click on Frame Rate to get a list of rates available —
make your choice by clicking on the one you wish to
employ; see page 22 for details.

Enter the number of wumverotFrames: @:}
frames you wish to cap-
ture in your video sequence; see page 23 for details.

Frame Rate:
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Click on Set — the settings will now become current. 1

Note: 1

If you change your mind click on Cancel and the pull-

down window will disappear.
Step 12

Click on Start — recording will now begin. The se-

quences, starting from the time you clicked on Start :

will now be recorded to your hard disk.

Please observe the status messages
below the video window as the pro-
gram grabs and saves the video se-
quences to disk.

Qi chwindowslsysiem
e 5
@ windows l

O systen
Cicardl Y

Drives: —m
Erame Rate: |15 1ps 3]
seng o [

[o—
Number of Frames: [0 |
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A Video Tutorial
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A Video Tutorial

7.1 AVI

(Audio Video Interleaved) A product developed by Microsoft which synchronizes
motion video and audio without the use of specialized hardware. This could be used
to create Talking Head presentations, display animation sequences and to present
multimedia slide shows.

7.2 Brightness

Brightnessis the ability to intensify colors on the screen. A good brightness control
allows the brightness of the image to be increased or decreased without changing
the image’s color attributes.

7.3 Compression
A digital process that allows data to be stored or transferred using less than the nor-

mal number of bits. DVIis an example of hardware compression and AVI is an ex-
ample of software compression.

7.4 Contrast
Contrast is the difference between light and dark. The higher the contrast a monitor

is capable of, the crisper the image appears.

7.5 DVI

Digital Video Interactive is a proprietary technology developed by Intel (and li-
censed by IBM) for full motion video at a high level of compression (hardware.)
This technology will be supported by Windows using MCI commands.

7.6 FLIC File

7.7 Flicker

Flicker is the perception of light changing intensity. On CRT monitors it is created
by the phosphor lighting up asitis struck by the electron beam and then fading when
the beam is turned off. The longer the phosphor glows, the less likely is it that the
image will flicker. Flicker is influenced by the monitor’s refresh rate. The slower
the vertical scanning frequency the more flicker.

Flickeris related to the similarities in the characteristics of the phosphorous and the
human eye. Light emitted by the phosphorous on the screen’s surface decays rapid-
ly. Similarly, light initiated by chemical reactions in the human eye decays (at a
slower rate), crating the impression of light even after the light source is removed.
When an image is refreshed before the chemical reaction of the eye has decayed,
then the eye perceives the image as a continuous steady image. When the image is
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refreshed after the chemical reaction of the eye has decayed, then the eye will per-
ceive a flickering image. The point at which the eye perceives a flicker is called the
flicker threshold.

If you open and close your eyes very rapidly for a few seconds you can create flicker
with your vision. While your eyes are open they are exposed to light and when you
close them the light disappears. It is the same principle on a CRT screen.

Flicker causes eye strain and headaches. It is more noticeable when using graphical
user interfaces (GUI’s) and graphical applications. The user’s peripheral vision no-
tices it more on monitors over 14”.

To avoid flicker vertical scanning frequencies of 79 Hz or higher should be used for
resolutions of 1024x768 and 640x480 resolutions. Vertical scanning frequencies of
70 Hz or higher is a must for users working with graphical applications as well as
Windows applications because of the white background which makes flicker more
noticeable.

7.8 MCI

Media Control Interface isa high level control software that provides adevice inde-
pendent interface to multimedia devices and media files. MCI includes a command
message interface and a command-string interface. This interface is supported by
both IBM and Microsoft.

7.9 Monitors — Grayscale
Greyscale monitors display up to 256 levels of grey. Greyscale isachieved by varia-
tions of the luminance value of white light from black to white.

19” 1280x1024 and down
217 1600x1280 and down

7.10 Monitors — Interlaced, Non-interlaced and Multiscan
These terms refer to the method used to scan the screen horizontally. Some high res-

olution monitors have too low of a horizontal scanning frequency to permit the dis-
play of all their pixels without flicker. These monitors use a scanning method called
interlacing.

Interlacing breaks the image into two fields, scanning all the even horizontal lines,
and then alternating, scanning all the odd horizontal lines. This is the lower cost
method of vertical scanning and the trade off is an increase in flicker.

Interlacing works very wellin cases such as television that displays scenes, compos-
ite, changing images. However, in text and graphic applications, horizontal lines
will flicker because the displayed static image is refreshed below the flicker thresh-
old frequency.

To minimize flicker interlaced CRT monitors use long persistent phosphors since
they glow longer than standard phosphors. Although long persistent phosphors
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glow longer, they are not as bright as normal persistent phosphors. In addition, long
persistent phosphors may cause lingering images (ghosts) when an image is re-
moved from the screen, i.e. when the cursor is moved using a mouse.
Non-interlaced monitors scan every line sequentially from top to bottom. As op-
posed to the every—other—row approach of interlacing, non—interlaced monitors
draw the complete image in one pass. Such monitors are significantly more expen-
sive, but produce flicker—free video in high resolution modes.

Multiscan or multiple frequency monitors can adjust to any frequency up to, and
in some cases, beyond its stated maximum, As each video resolution comes with
a defined set of horizontal and vertical scanning frequencies, a multiple-frequency
monitor synchronizes to the particulars of a wide range of video modes.

7.11 Monitor Sizes
Low resolution applications, such as DOS based word processing generally use 13”

and 14” monitors. CAD applications, graphic user interfaces (GUI’s) and desktop
publishing applications requiring very sharp crisp images use 17, 19”,20” and 25”
monitors.

As a general rule of thumb, the following minimum resolutions should be used with
the corresponding size monitor.

14” 800x600 and down
16” 1024x768 and down
17”7 1024x768and down

7.12 Palette

A card’s palette size is determined by the maximum number of colors it can create.
An adapter’s palette size is directly determined by the amount of memory on the
card. In Windows, a palette is a data structure defining the colors used in a bitmap
image.

7.13 Pixel

A single point of an image. A screen’s resolution is commonly referred to in pixels.

7.14 Resolution

A monitor displays images by breaking them down into very small raster elements
called pixels (picture elements), which are the smallest information building blocks
of a display image. On color monitors each pixel is made up of one or more colors;
blue, green and red. The size of a pixelis measured in dots per inch (dpi.) The small-
er the pixel, the more pixels can be placed in a horizontal row. The smaller the pixel
the finer the resolution and therefore the sharper the display image.
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A monitor with a resolution of 640x480 has 640pixels in each horizontal row and
480 horizontal rows. By multiplying those numbers, i.e. 640x480, you get
307,200,the total number of pixels the screen can display. Therefore an in image
consisting of 320x200 pixels (64,000 pixels per image) is very coarse, while an
image of 1280x1024 pixels (1,310,720 pixels per image) is very fine.

The maximum resolution of a monitor is determined by the size of the pixels (dpi),
the horizontal scanning frequency and the width of the monitor. Assuming the same
horizontal scanning frequency and the the same size of pixels, an image displayed
on a 14 ” monitor with a 640x480 resolution looks smoother and finer than when
displayed on a21” monitor with a 640x480 resolution because the dpi or dot density
is higher on a 14” monitor. The formula for figuring the dots per inch of a monitor
is to divide the maximum number of pixels in the horizontal direction by the hori-
zontal screen dimension in inches i.e. 640/14 =45.71 dpi.

Resolution does not describe the quality or sharpness of the image displayed by the .

monitor. It is only the capability, one limited by the signal from the video controller,

to address a number of pixels. Therefore, resolution figures should not be used as

ameasure of image quality but of compatibility(whether the monitor will work with
specific signals from the video controller.) The actual sharpness of an image is in-
fluenced by a combination of factors, including the electronics of the monitor, the
CRT (Cathode Ray Tube), the mechanical construction of the monitor and even the
size of the screen.

7.15 Scanning Frequencies
The horizontal scanning frequency, measured in KHz, determines the maximum

amount of information that can be placed on one horizontal line during one scan of
that line. For instance, a monitor with a horizontal scanning frequency of 31.5 KHz
can place more information on a horizontal line than a monitor with a 15.75 KHz
horizontal scanning frequency.

The vertical scanning frequency, measured in Hz, is referred to as the refresh rate.
It determines how fast the monitor can scan from top to bottom of the screen to dis-
play the image. A monitor with a 60 Hz vertical scanning rate will refresh the entire
screen sixty times per second.

Vertical and horizontal scanning frequencies are interdependent. If the resolution
is to stay the same when the vertical scanning frequency is increased the horizontal
scanning frequency must increase also. For instance: suppose you have a 640x480
monitor with a 60 Hz vertical scanning frequency and a31.5 KHz horizontal scan-
ning frequency. Ifthe vertical scanning frequency isincreased to 72 Hz then the hor-
izontal scanning frequency must increase to approximately 36 KHz.
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7.16 Scanning Images
A monitor can not display any video without a video controller (also known as a

Graphics Card or a VGA Adapter.) A video controller stores the entire image in the
form of pixels in its RAM (Random Access Memory) and then sends the informa-
tion to the monitor. Although the video controller can store all the pixels, the moni-
tor can display only one pixel at a time. Therefore the video controller must send
each pixel to the monitor one at a time (serially.)

The video controller begins displaying the image by sending all the pixels for the
firstline to the monitor causing the guns (part of the monitor) to send abeam of elec-
trons that sweep across the toprow of the screen from left toright. After all the pixels
for the first row have been sent and the electron beam reaches the right hand side
of the screen the video controller sends a special signal, called the horizontal sync
(synchronization) pulse to tell the gun to begin a new row. The beam is turned off,
the gun moved a row down and to the left hand side of the screen and then swept
across the screen again from left to right. (This is the same pattern we use when we
read.)

This sweeping or scanning process continues until the gun reaches the bottom of the
screen. The video controller the issues a vertical sync pulse to the monitor instruct-
ing it to start anew image on the first line. The electron beam is then turned off while
the gun is aimed at the top of the screen again where it begins scanning the entire
screen again. This process is referred to as horizontal scanning and vertical scan-
ning. Scanning rates are measured in units of Hertz. One Hertz (Hz) is one cycle
per second and one thousand Hertz is one thousand cycles per second or one kilo
Hertz (KHz.)

Images are formed during the scanning process by turning the electron beams on
and off as the gun sweeps across the screen. The beam is turned of where no image
is to appear. When the beam is turned on it strikes the phosphor, causing it to glow.
The glowing phosphor is seen as a spot of light on the front of the monitor;(the gun
and the phosphor is behind the screen, on the inside of the monitor.) Since the phos-
phor glow fades quickly, the screen must be continuously scanned to sustain the
image.

7.17 Sync Signals

Horizontal and vertical sync signals from the video controller tel the circuitry in the
monitor when and where to aim the gun. All the sync characteristics of the monitor
must match the same characteristics in the video controller.

Multiscanning or multisyncing monitors are preferred because they instantly tune
in a wide range of video modes and resolutions as long as the scanning range of the
video controller does not exceed the range of the monitor. Better super VGA con-
trollers feature multiscanning.
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7.18 Sync Signal Types
Analog sync signals may be combined (one signal for both horizontal and vertical

syncs on one line) or separate (two signals, one for each of the two syncs.)
Composite Sync

A method that combines the horizontal and vertical sync on one input line.

RGB Separate Sync

Separate sync sends the horizontal and vertical sync positioning signals from the
video controller to the monitor on their own separate line; They typically use 5 BNC
connectors.

RGB Sync on Green

A method that combines the horizontal and vertical sync on one video input lines;
normally green in color monitors.

7.19 WAVE File »
A Microsoft standard file format for storing waveform audio data. WAVE files have
a .Wav filename extension.
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REELtime is designed as a tool for creating video clips that can be used in multime-
dia presentations, or edited in programs like Animator Pro and PhotoStyler. What
used to take hours by grabbing single frames and converting to the correct file for-
mat can now be done in a matter of seconds with REELtime. Using a presentation
package like ImageQ from ImageNorth, you can add audio to the clip during your
presentation.

Editing your REELtime clips

After you have saved your video clip to an FLC file, you can take the clip into Auto-
desk Animator Pro to edit it. Under Animator Pro you can discard frames, adjust
colors and add animated objects, backgrounds or text to the clip.

If you save the video clip to TGA files, you can use any of several image processing
packages to edit the frames and finally assemble the frames into an FLC file using
Animator Pro. Using combinations of programs like Aldus PhotoStyler and Gallery
Effects, you can apply stunning effects to your clips such as a clear sky changing
to stormy weather, or a water—colored person coming to life over a series of frames.

Using REELtime clips in a presentation

After you have saved a video clip to an FLC file you can use the file as part of amul-
timedia presentation. Using a presentation package such as ImageQ or HSC Inter-
Active, the FLC file can be simply inserted into a script along with still images, live
video, or audio files to create an exciting show on the PC. The FLC file could also
be converted to an AVI file in Microsoft’s Video for Windows package, allowing
the audio to be synchronized to the video clip.
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